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1 System Overview

1.1 Cautions and Warnings
The EVM is designed to operate by professionals who received appropriate technical training, yet it is
designed to operate from AC supply. Read the safety related documents that come with the EVM package
and the user guide before operating this EVM.

CAUTION
Read user guide before use.

CAUTION
Do not leave the EVM powered when unattended.

CAUTION
HOT SURFACE: Contact may cause burns. Do not
touch.

CAUTION
HIGH VOLTAGE: Electric shock possible when
connecting board to live wire. The board should be
handled with care by a professional. For safety, use
isolated equipment with overvoltage and overcurrent
protection.

1.2 System Description
This document discuss a two-phase power measurement application using a simple low-cost Texas
Instruments microcontroller (MCU) MSP430i2040. The MSP430i2040 is a mixed signal MCU that
integrates with four differential input, 24-bit Sigma-Delta (SD24) analog-to-digital converters (ADCs) with a
programmable gain amplifier, a 16-bit hardware multiplier, an eUSCI_A0 supported UART, SPI
communication interface, an eUSCI_B0 supported SPI, an I2C, two 16-bit timers, and 12 I/O pins in a 28-
pin TSSOP or 16 GPIO pins in a 32-pin QFN package. The peripheral set is a good combination for
electricity power measurement.

In this document, all descriptions of the setup, operations, features, behaviors, functions, and interfacing
are based on the default firmware and the original hardware design. Proper functionality is not guaranteed
if changes are made to the hardware or firmware.
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2 Design Features

2.1 Basic Operations
In this design, all four SD24 ADCs on the MCU are used: Two for the two-phase voltage and two for the
current of each phase. The Sigma-Delta ADCs run at approximately a 1.024-MHz modulator frequency
fixed by the hardware. The sample frequency is derived from the modulator frequency divided by 256
equals 4 kHz, which give a Nyquist bandwidth of 2 kHz. This bandwidth is sufficient to cover the 31st
harmonic for 60-Hz AC and 40th harmonic for 50-Hz AC frequency.

Figure 1 shows the system functional diagram, the four SD24 ADCs take samples from two voltage and
two current channels with the calibrated and programmed fractional delay. The samples then pass through
a DC removal filter. Each DC removal filter dynamically tracks the DC offset of the ADC (and the signal)
by analyzing each sample and removing any DC before passing the sample to AC processing.

The current samples and the voltage samples then perform a square and accumulate to get the root mean
square current (Irms) and voltage (Vrms). The current samples will also multiply and accumulate with the
voltage sample of its phase with proper additional phase delay (if needed) to get the active power (Pactive)
and with the corresponding 90-degree shifted sample to get the reactive power (Preactive).

After eight AC cycles, the system sets a flag to show results that need to process. Triggered by this flag,
the system then performs the scaling and converts those accumulated values into values of proper units
(V, A, W, and so on).

Figure 1. System Functional Diagram
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2.2 Board Overview

Figure 2. Board Overview

4 Two-Phase Embedded Metering TIDU641–November 2014
Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU641


6' Modulator 

-

Power Inlet

Load A

Shunt IA

VA

6' Modulator 

+

+

-

RST

VCC

MSP430i2040
VSS

UCxTXD00

UART 
9600 

Px.x

UCxRXD00

LED

Li
ve

 2

Power Inlet

Load B

Shunt

N
eu

tr
al

Modulator 

-

Modulator 

+

+

-

6'

6'

IB

VB

Li
ve

 1

Li
ve

 1

www.ti.com Block Diagram

3 Block Diagram
Figure 3 is the block diagram of the system.

Figure 3. System Block Diagram
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4 Circuit Design and Component Selection
The design of this metering circuit can be divided into several sub-systems. This design guide only
discusses the design of the sensor sub-system.

4.1 Interface Circuit
In the design of a metering circuit, a key success factor to yield sufficient accuracy very much depends on
a good sampling circuit. The four SD24 ADCs on the MSP430i2040, together with the on-chip
programmable gain amplifier, provide the critical hardware for getting high quality AD conversion result
from both current and voltage sensor. Moreover, the interface circuit, the component selection, and the
circuit layout also play a crucial role for a successful design.

Due to the nature of a Sigma-Delta ADC and of the voltage and current signal being measured, the design
needs an external interface circuit to interface the voltage and current to keep the Sigma-Delta ADC
working properly and provide proper filtering for the band of interest.

The hardware of the interface circuit is simple, which composes of basically passive components apart
from the protection diode. Figure 4 shows the interface circuit designed. The two sets of circuit are exactly
the same for the shunt resistors and interface to voltage sensor.

In the current sensor interface circuit with R6 (A, B) being the shunt sensor, D1 (A, B) is the optional
protection diode. The protection diode is not required unless, for example, a high shunt resistor value or a
current transformer is in use instead of the current sensor and the user anticipates a significant current
surge to send enough voltage across the sensor high to damage the MCU.

L1 (A, B), R9 (A, B), and C9 (A, B) form a low-pass filter having a bandwidth of a few MHz. The purpose
of this filter is to reject radio frequency interference from going into the SD24 ADC. The filter formed by L2
(A, B), R8 (A, B), and C8 (A, B) has the same characteristic, which is balanced for the differential signal.
The filter formed by R9 (A, B), R8 (A, B), and C10 (A, B) is a filter that gives a bandwidth of about 10 kHz,
which is the filter for the band of interest.

The order of magnitude of these capacitors should be observed although the actual value of the
capacitance is not that critical.

The voltage sensor interface is a resistor ladder. The ratio of the resistance in the resistor ladder allows up
to 265-V AC and 420-V DC to be measured. The current sensor filter is similar except that the value of
R10 (A, B) is 100 Ω, not 1 kΩ. The reason for this is the voltage divider circuit has an equivalent source

resistance in series with R10. To balance the filter for the differential signal, the
sensor uses a small R10 (A, B) value. The combined effect is of similar value to R11 (A, B). Although
there is a slight mismatch using the designed value, this effect has no observable impact to accuracy.
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Figure 4. Voltage and Current Sensor Interface Circuit
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4.2 Component Considerations

4.2.1 Shunt Resistor
For accurate measurements, the choice of shunt is another important factor. In practice, a shunt of smaller
value (<1 mΩ) is a better choice than a larger value (>2 mΩ). A smaller shunt value benefits the power
dissipated on the shunt and the respective rise in temperature. The lower rise in temperature reduces the
need for a very low temperature coefficient shunt resistor to sustain the accuracy. However, small value
shunts also have drawbacks. The signal-to-noise ratio (SNR) of a small value shunt is worse than using a
larger value one. In this sense, there may be chance that a shunt of higher value is desired, such as when
measuring a very small current and the range of the current to be measured is also small. Therefore, a
design needs to consider these factors: the maximum current, the current dynamic range, the heat
generated on the shunt, and the ventilation of that heat.

In this application, the maximum current for each socket is 30 A, and the desired dynamic range of current
keeping flat error percentage is 1000:1 (30 A : 30 mA). The power dissipated on the shunt resistor should
be as small as possible.

To achieve the best accuracy, have the ADC meet its maximum input amplitude (900-mV peak) when
presented with the maximum current of the design (30 Arms). Because the SD24 ADC has an input range
of approximately 900 mV at x1 gain, using a x8 gain the input range for AC root mean square is

(1)

With this number, a 2-mΩ shunt resistance should be good for this input range with the give maximum
current (at 30 A, 2 mΩ gives a 60-mV signal amplitude) still leaving about 10 A in head room.

In addition to value, the physical size of the shunt is also an important factor to accuracy—not the size
directly, but the heat generated when current flows. A smaller sized shunt heats up more easily due to the
limited surface area and volume. If there is significant current to flow though the shunt, have a large
enough sized shunt and sufficient ventilation on the PCB to prevent heat from accumulating. This design
uses a 4026-sized shunt. At 2 mΩ, the power dissipated on the shunt at maximum current is 302 × 2 = 1.8
W, which is about 60% the rated power of a 4026-sized 3-W shunt resistor.

4.2.2 Voltage Divider Circuit
For the voltage sensor circuit, the matter is a little simpler. In this design, the major consideration is that
the voltage divider should be able to prevent arcing between the terminals. To reduce the voltage
difference between resistor terminals, this design uses four resistors (instead of two) to form the voltage
divider [R1 (A, B), R13 (A, B), and R14 (A, B) are 330 kΩ, and R15 (A, B) is 1.5 kΩ]. Then the voltage
across R1, R13, and R14 each take about one-third of the AC voltage. Now at a 220-V input, each resistor
has a voltage drop of about 75 V across. Using the 2512 resistor for R1, R13, and R14 then further
separates the live voltage and R15.

The installation of D8 (A, B) in the voltage sensor circuit is more important than D1 (A, B) in the current
circuit. The reason is that the resistor ladder on the voltage sensor circuit is more likely to see a voltage
surge across R15 high enough to damage the MCU. If R15 is open circuit or in bad contact, causing a
higher resistance the voltage across the input of the voltage channel ADC also damages the MCU.
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4.3 Configurations
This design allows different connections to the EVM so different measurement configurations can be set
for different application needs. The two configurations are show in Figure 5 and Figure 6:

Figure 5. Configuration 1
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Figure 6. Configuration 2

10 Two-Phase Embedded Metering TIDU641–November 2014
Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU641


www.ti.com Software Description

5 Software Description

5.1 Firmware Structure
The firmware comes with the this design package is designed to use a layered approach, isolating the
user from the details of metrology and the associated computations involved so that the programming
work is simplified. In users view the firmware is partitioned into 3 main blocks The application, which
performs : system setup and initialization, main loop, communication protocol and command handling,
non-volatile parameters preset and manipulation. The toolkit packaged, which is packed into a library
named “emeter-toolkit-i2041.r43”, contains low level computation routines.

The firmware is designed to use a layered approach, isolating the user from the details of metrology and
the associated computations involved to simplify the programming work.

In the user's view, the firmware is partitioned into three main blocks:
• The application, which performs the system setup and initialization, main loop, communication protocol

and command handling, non-volatile parameters preset, and manipulation
• The toolkit packaged, which is packed into a library named “emeter-toolkit-i2041.r43”, contains low-

level computation routines
• The metrology computation engine, which is packaged into a library named “emeter-metrology-i2041-2-

phase.r43”, contains the function for ADC setup and initialization, sample-based background
processing, reporting cycle-based foreground processing, and result reading API

NOTE: This package does not include the source code of this library. Contact a local Texas
Instruments Sales Team if the source code is needed.
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5.2 Metrology Computation Engine
The metrology computation engine performs the actual sampling and computation based on the
information collected from the voltage and current ADC channels. The engine acts in a time-critical
background process and a less time-critical foreground process.

The background process is triggered by the ADC at the sample rate. This process runs in the interrupt
services routine of the ADC and is processed automatically.

The foreground process is triggered by the completion of background process at the reporting and update
rate. The background process sets the flag PHASE_STATUS_NEW_LOG in the variable phase_state to
indicate that data is ready to be processed by the foreground. The application then needs to monitor this
flag to trigger the foreground process by calling to calculate_phase_readings ().

In the actual computation, use the following formulas in the metrology computation:

(2)

(3)

(4)

(5)

(6)

(7)

5.2.1 Background Process
The background performs a straight-forward, time-critical, sample-based process. The process starts by
an SD24 interrupt trigger at the sample rate. The background process then
• Captures data from voltage and current ADC channels
• Performs voltage sample processing
• Performs current sample processing
• Performs power processing
• Performs line frequency processing
• Triggers the foreground process

5.2.2 Foreground Process
After reaching the report cycle, the background sets the flag PHASE_STATUS_NEW_LOG. The user
main loop checks the status of this flag and calls to the foreground process calculate_phase_readings () to
compute the rest and deliver the measurement readings. The foreground process then calculates the
active power, reactive power, apparent power, RMS voltage, RMS current, power factor, and frequency of
the AC line.
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6 Test Setup

6.1 Apparatus
The following list of instruments help calibrate and test the EVM (See instrument link in Section 9):
• AC meter test set
• A reference meter that could read AC parameters based on the voltage, current, and phase setting

from the AC meter test set

6.2 Setup

Figure 7. Connection to AC Meter Test Set
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7 Test Results

Figure 8. Phase A Accuracy Test Results

Figure 9. Phase B Accuracy Test Results

7.1 Test Summary
With the test settings and proper calibration, this design achieves an accuracy of <0.2% error over a 30-
mA to 30-A range and <0.5% error over a 10-mA to 30-A range. The higher percentage error in the low
current range is due to noise seen on the shunt resistor. The effect of noise diminished as the test current
increased.
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8 Design Files

8.1 Schematics
To download the schematics, see the design files at TIDM-2PHASE-SUBMTR.

Figure 10. TIDM-2PHASE-SUBMTR Main Board
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Figure 11. Isolated Serial Board

16 Two-Phase Embedded Metering TIDU641–November 2014
Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU641


www.ti.com Design Files

8.2 Bill of Materials
To download the bill of materials (BOM), see the design files at TIDM-2PHASE-SUBMTR.

Table 1. TIDM-2PHASE-SUBMTR Main Board BOM

QTY DESIGNATOR VALUE DESCRIPTION MANUFACTURER PARTNUMBER FOOTPRINT
CAP, TANT, 10 µF, 10 V, ±20%, 2.5 Ω, 3528-211 C19 10 µF Vishay-Sprague 293D106X0010B2TE3 3528-21SMD
CAP, TANT, 220 µF, 6.3 V, ±10%, 0.6 Ω, 7343-1 C28 220 µF Vishay-Sprague 293D227X96R3D2TE3 7343-3131 SMD

4 H5, H6, H7, H8 Standoff, Hex, 0.5"L #4-40 Nylon Keystone 1902C Keystone_1902C
C8A, C8B, C9A, C9B, C12A, CAP, CERM, 47 pF, 50 V, ±5%, C0G/NP0,8 47 pF AVX 06035A470JAT2A 0603C12B, C13A, C13B 0603

1 FR Fuse, 1 A,125 V, SMD Cooper Bussman 6125FA1A 6125FA
1 C21 DNA CAP, CERM, 2200 pF, 50 V, ±10%, X7R, 0603 Kemet C0603X222K5RACTU 0603
2 C11, C20 0.1 µF CAP, CERM, 0.1 µF, 10 V, ±10%, X5R, 0402 TDK C1005X5R1A104K 0402

CAP, CERM, 470 nF, 16 V, [TempCo], xx%,1 C4 470 nF Taiyo Yuden EMK107F474ZA-T 0603[PackageReference]
R8A, R8B, R9A, R9B, R11A,6 1.00 k RES, 1.00 kΩ, 1%, 0.1 W, 0603 Vishay-Dale CRCW06031K00FKEA 0603R11B

1 R16 4.7 k RES, 4.7 kΩ, 5%, 0.1 W, 0603 Vishay-Dale CRCW06034K70JNEA 0603
2 R15A, R15B 1.50 k RES, 1.50 kΩ, 1%, 0.125 W, 0805 Vishay-Dale CRCW08051K50FKEA 0805
2 R10A, R10B 100 RES, 100 Ω, 1%, 0.1 W, 0603 Vishay-Dale CRCW0603100RFKEA 0603
1 R34 330 RES, 330 Ω, 5%, 0.1 W, 0603 Vishay-Dale CRCW0603330RJNEA 0603
6 R49, R50, R51, R52, R53, R54 0 RES, 0 Ω, 5%, 0.1 W, 0603 Vishay-Dale CRCW06030000Z0EA 0603
4 C10A, C10B, C14A, C14B 0.015 µF CAP, CERM, 0.015 µF, 16 V, ±10%, X7R, 0603 MuRata GRM188R71C153KA01D 0603
1 J9 Header, 4-Pin 3-644456-4

Hole for Banana2 NEUTRAL_IN, NEUTRAL_OUT N/A Used in BOM report Socket
Hole for Banana1 LIVE_1_IN N/A Used in BOM report Socket
Hole for Banana1 LIVE_1_OUTA N/A Used in BOM report Socket
Hole for Banana1 LIVE_1_OUTB N/A Used in BOM report Socket
Hole for Banana1 LIVE_2_IN N/A Used in BOM report Socket
Hole for Banana1 LIVE_2_OUT N/A Used in BOM report Socket

4 L1A, L1B, L2A, L2B Inductor, Ferrite Chip 120 Ω 0805 Murata Electronics BLM21BD121SN1D YW0805
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Table 1. TIDM-2PHASE-SUBMTR Main Board BOM (continued)
QTY DESIGNATOR VALUE DESCRIPTION MANUFACTURER PARTNUMBER FOOTPRINT

2 LED1, LED5 Red Lite-On Inc LTST-C170KRKT 0805-LED
2 LED2, LED6 Green Lite-On Inc LTST-S220KGKT 0805-LED
2 LED3, LED7 Blue Lite-On Inc LTST-C170TBKT 0805-LED
1 LED4 White Lite-On Inc LTW-170TK 0805-LED
1 P1 Header, 7-Pin, Dual row TE Connectivity A104860-ND 2X7BOXHEADER
1 U1 MSP430i2040 Texas Instruments MSP430i2040PW TSSO10x6-G28

Machine Screw, Round, #4-40 × 1/4, Nylon,4 H1, H2, H3, H4 B&F Fastener Supply NY PMS 440 0025 PH NY PMS 440 0025 PHPhilips panhead
Header, TH, 100-mil, 1×3, Gold plated, 230 mil Sullins Connector1 J8 1×3 PBC03SAAN PBC03SAANabove insulator Solutions

1 !PCB Printed Circuit Board Any
R1A, R1B, R13A, R13B, R14A,6 330 k Resistor, 330 kΩ, 1 W, 1% TE Connectivity 1-2176071-0 R2512R14B

7 R2, R3, R4, R5, R7, R12, R17 390 RES, 390 Ω, 5%, 0.1 W, 0603 Yageo America RC0603JR-07390RL 0603
RES, Open Ω, x%, xW, 0603

3 R31, R32, R33 DNA RES, xxx Ω, x%, xW, [PackageReference] Used in BOM report Used in BOM report 0603
RES, xxx Ω, x%, xW, [PackageReference]

4 D1A, D1B, D8A, D8B Littelfuse Inc SMAJ5.0CA DSO-C2/X1.8
1 D7 7 V Diode, TVS, Uni, 7 V, 600 W, SMB Diodes Inc. SMBJ7.0A-13-F SMB

CONN SHRD HDR HDR 20 POS 1.27 MM Samtec_TFM-110-02-2 RF1, RF2 Samtec TFM-110-02-S-D-A-K-TRSLDR ST SMD S-D-A-K
Thermal Transfer Printable Labels, 0.650" W ×1 LBL1 Brady THT-14-423-10 Label_650x2000.200" H - 10,000 per roll
Header, TH, 100-mil, 2×2, Gold plated, 230 mil1 J5 Samtec, Inc. TSW-102-07-G-D TSW-102-07-G-Dabove insulator

2 R6A, R6B Shunt Resistor Vishay Dale WSL40262L000FEB Current Sensing Pad
1 D6 Littelfuse Inc V320SM7 V320SM7
1 U4 Onboard block power supply CUN Inc VSK-S1-3R3U VSK-S1
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Table 2. Isolated Serial Board BOM

QTY DESIGNATOR COMMENT DESCRIPTION LIBREF PARTNUMBER FOOTPRINT
CAP, CERM, 0.1 µF, 50 V, ±10%,2 C24, C25 C1608X7R1H104K C1608X7R1H104K C1608X7R1H104K 0603X7R, 0603
CAP, TA, 10 µF, 10 V, ±10%, 1.8 Ω,2 C26, C27 T495A106K010ATE1K8 T495A106K010ATE1K8 T495A106K010ATE1K8 3216-18SMD

4 D2, D3, D4, D5 LL103A LL103A LL103A SOD-80
Receptacle Assembly, 9 Position,1 J7 D Connector 9 D Connector 9 DSUB9-FRight Angle
Transistor, PNP, 45 V, 0.1 A, SOT-2 Q1, Q2 BC857C-7-F BC857C-7-F, Diodes Inc. BC857C-7-F SOT-2323
RES, 2.2 kΩ, x%, xW,2 R18, R21 2.2k Resistor Used in BOM report 0603[PackageReference]
RES, Open Ω, x%, xW,1 R19 Open Resistor Used in BOM report 0603[PackageReference]
RES, 1 kΩ, x%, xW,2 R20, R23 1k Resistor Used in BOM report 0603[PackageReference]
RES, 68 Ω, x%, xW,1 R22 68 Resistor Used in BOM report 0603[PackageReference]
RES, 10 kΩ, x%, xW,1 R24 10k Resistor Used in BOM report 0603[PackageReference]
RES, 1.5 kΩ, x%, xW,1 R25 1.5k Resistor Used in BOM report 0603[PackageReference]
RES, 220 Ω, x%, xW,1 R26 220 Resistor Used in BOM report 0603[PackageReference]

HEADER_SFM-110-02- HEADER_TFM-110-02- HEADER_TFM-110-2 RF1, RF2 Header, SMT 10×2 pin, Shrouded SFM-110-02-SM-D-A-K-TRSM-D-A-K-TR SM-D-A-K-TR 02-SM
2 U2, U3 PS8802-1 PS8802-1 PS8802-1 SO-8
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8.3 PCB Layout
To download the layer plots, see the design files at TIDM-2PHASE-SUBMTR.

8.3.1 TIDM-2PHASE-SUBMTR

Figure 12. Top Overlay Figure 13. Top Solder

Figure 14. Top Layer Figure 15. Top Paste
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Figure 16. Bottom Paste Figure 17. Bottom Layer

Figure 18. Bottom Solder Figure 19. Bottom Overlay
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Figure 20. Drill Guide Figure 21. Board Dimensions

8.3.2 Isolated Serial Board

Figure 22. Top Overlay Figure 23. Top Solder
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Figure 24. Top Layer Figure 25. Top Paste

Figure 26. Bottom Paste Figure 27. Bottom Layer

Figure 28. Bottom Solder Figure 29. Bottom Overlay

23TIDU641–November 2014 Two-Phase Embedded Metering
Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU641


Design Files www.ti.com

Figure 30. Board Outline Figure 31. Board Dimensions

8.4 Altium Project
To download the Altium project files, see the design files at TIDM-2PHASE-SUBMTR.

8.5 Gerber Files
To download the Gerber files, see the design files at TIDM-2PHASE-SUBMTR.
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8.6 Assembly Drawings

8.6.1 TIDM-2PHASE-SUBMTR

Figure 32. Top Assembly Drawing Figure 33. Bottom Assembly Drawing

8.6.2 Isolated Serial Board

Figure 34. Top Assembly Drawing Figure 35. Bottom Assembly Drawing

8.7 Software Files
To download the software files, see the design files at TIDM-2PHASE-SUBMTR.
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Appendix A Example Application Code

A.1 Introduction
Project structure:
• emeter-communication.c – source code for low level UART communication routines including UART

port setup, write and read from UART, interrupt services routine for byte-wise send and receive
• emeter-dlt645.c – source code for the polling mode protocol implementation
• emeter-main.c – source code for system initialization, main loop, callback functions implementation and

interrupt vector placement
• emeter-metrology-i2041-2-phase.r43 – embedded metering library object code
• emeter-setup.c – source code for low level system initialization
• emeter-template.h – source code for configuration
• metrology-calibration-default.c – source code to put the user defined default calibration parameter into

a proper data structure (do not modify this file)
• metrology-calibration-template.h – source code of user defined default calibration parameter

27TIDU641–November 2014 Example Application Code
Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU641


Preparing the Application Code to Run www.ti.com

A.2 Preparing the Application Code to Run

1. Launch the IAR5.5 Embedded Workbench IDE and click on File→Open→Workspace.
2. Select emeters.eww when prompted to open Workspace.

Figure 36. Opening Workspace

3. Select the emeter-app-i2041 project tab at the bottom of the Workspace window.
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4. Check project options by right clicking the project name and select Options… from the pop-up menu
(see Figure 37).

Figure 37. Project Tab

5. When the options appear, select C/C++ Compiler on the left-hand column. Then select the
Optimizations tab on the right-hand side and check the optimization settings as shown in Figure 38.

Figure 38. Optimization Options
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6. Select FET Debugger on the left-hand column, then select the Setup tab. The EVM uses Spy-Bi-Wire
for its code downloading and debugging. Check to make sure the options are as shown in Figure 39.

Figure 39. Debugger Options

7. Select the Download tab. Under Flash erase, do not choose Erase main memory and Information
memory; this option erases both sets of data and cannot be recovered. Instead, choose Erase main
memory as the download option to preserve these factory parameters: system clock calibration, ADC
calibration, and internal reference calibration (see Figure 40). However, metrology calibration stored in
the main memory, such as VGAIN, IGAIN, PGAIN, and so on, are always erased after downloading.

Figure 40. Download Options

8. Click OK after completing all of the changes.
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9. Rebuild the project by right-clicking on the project and select Rebuild All from the pop-up menu (see
Figure 41). Three warnings will be reported during rebuilding (see Figure 42), which are safe to ignore.
To open the project workspace and modify, compile, and download the code, the user must have IAR
Embedded Workbench 5.5 installed with a valid license. If a valid license is not available, the user can
still download the object code. See Section A.3 for downloading procedures.

Figure 41. Compiling the Application

Figure 42. Warnings
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10. Make sure the jumper on J8 is short properly. Connect the 14-pin connector P1 to MSP-FET430UIF by
a flat cable as shown in Figure 43.

CAUTION
The debugging interface is not isolated. Make sure to
properly isolate between the EVM and the PC used for
debugging with AC or DC high voltage connected.

NOTE: Connection to debugging interface is optional for the operation of the EVM. The EVM can
operate without a debugger connected.

Figure 43. Connecting EVM and FET
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11. Click the Download and Debug button to download and debug (see Figure 44).

Figure 44. Code Downloading

12. After successfully completing the download, Figure 45 appears. Click Go to run the application.

Figure 45. Debugger Screen

33TIDU641–November 2014 Example Application Code
Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU641


Preparing the Application Code to Run www.ti.com

Figure 46. EVM Running
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A.3 Downloading Without an IAR License
If a valid IAR Embedded Workbench 5.5 license is not available, download the executable code to the
board with the following steps using the installed IAR Embedded Workbench 5.5.
1. Open the project workspace as described in Section A.2, Steps 1 through 7. Then connect the board to

the MSP-FET430UIF as described in Step 10 in Section A.2.
2. Select Project→Download→Download File… from the menu (see Figure 47).
3. When prompted to select a file, go to the folder [Submeter i2040

4k_2_PHASES_AUTO_OSR_IAR5.5]\emeter-app\emeter-app-i2041\Debug\Exe and select the file
named “emeter-app-i2041.d43” (Figure 48).
The executable code will then download to the board.

Figure 47. Download Executable File

Figure 48. Select File to Download
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Appendix B EVM Operation

B.1 Download Application Code
Download application to the board by using the IAR compiler as described in Appendix A.

B.2 Setup the EVM Hardware

CAUTION
Do not supply power to the EVM until the hardware
and software setup is completed.

Install jumper to J5 as shown in Figure 49.

Figure 49. EVM J5 Jumper Setting
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Install the isolated serial communication module as shown in Figure B 3 and connect EVM to a serial port
on the PC.

Figure 50. Serial Communication Module Installation
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B.2.1 Install and Run PC Software

B.2.1.1 Installing PC Software
Unzip the file named "calibrator-runtime.zip” into any folder. A folder named calibrator-runtime containing
the necessary files to run the software tool will be in that folder. The file named "calibrator-20121120.exe"
is the executable file of the software tool. The file named “calibrator-config.xml" contains the setup
information for the software tool. Users must make a few edits to this XML file before calibrator-
20121120.exe can launch.

B.2.1.2 Configuring PC Software
Follow these steps to setup the XML to run calibrator-20121120.exe properly:
1. Right click the My Computer icon and select Properties in the pop-up menu.
2. Select Device Manager to go to the Device Manager window and check the COM port number of the

serial port that connecting the PC and the EVM (see Figure 51).

Figure 51. Device Manager Window
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3. Open “calibration-config.xml” in the folder calibrator-runtime with a text or XML editor. Go to the line
highlighted in Figure 52, put in the COM port number in, and save the file.

Figure 52. Editing “calibration-config.xml”
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B.3 Start Using the EVM
To run the readied EVM, connect the correct AC wiring to labeled input and apply AC power. Then launch
the software “calibrator-20121120.exe” in the folder calibration-runtime to start communicating with the
EVM. A window as shown in Figure 53 appears. As defined in the XML file “calibration-config.xml”, meter
position 1 is assigned the serial port to communicate with the EVM. The Comms indicator will turn green if
communication to EVM from PC is established, and it will flash between red and green when the
communication takes place.

Figure 53. Calibrator Software Startup Window
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Click on the Comms indicator to show the Meter status window as shown in Figure 54.

Figure 54. Meter Status Window

This window shows the current reading of the meter. The background of a reading box is gray if the EVM
does not support that particular reading. The box turns red if the reading from EVM to that box has a large
variance, yellow if the reading from EVM has a fairly low variance, and green if the reading has a low
variance.

NOTE: The software on PC reads the EVM every second and averages the data read, meaning the
update rate is slower than the update rate of the EVM.
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At the bottom of this window, there are four buttons.
• The Meter consumption button brings up the Meter consumption window. This window gives no useful

information because the EVM does not support this feature.
• The Meter calibration factors button brings up the Meter calibration factors window, which shows the

current calibration factor values (see Figure 55).

Figure 55. Meter Calibration Factors Window

• The Meter features button brings up the Meter features window. This window reports the support
feature of the EVM (see Figure 56).

Figure 56. Meter Features Window
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• Click on the Manual cal button to bring up the Manual cal window (Figure 57). In this window, adjust
the calibration factor values by entering the percentage error of the reading from the EVM and
compare to the reading from the reference meter. The technique and procedure of performing
calibration will be discussed in further detail in Appendix C.

Figure 57. Meter Error Window

To modify the calibration factor, enter the correction in the percentage error. The percentage error is
calculated as follows:

(8)

Put the percentage error into its corresponding box in the Meter calibration window. Click Update meter to
calculate and write the updated calibration values to the EVM. The corresponding values will be reflected
on the Meter calibration factor window (Figure 55).

B.4 Known Issues
The calibrator software is legacy software that operates with utility meters that have not been customized
completely for embedded metering. The following is a list of known issues with the existing software that
will be fixed in the next version of calibrator software customized for embedded metering.
• Voltage AC offset values cannot be written with the calibrator software. The value put into the voltage

AC offset box is written to the current AC offset instead. The value put into the current AC offset box
has no effect.

• The aggregate current in Meter status windows always shows 10.0000 A.
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Appendix C EVM Calibration

C.1 Introduction
The EVM is programmed with calibration values that allow the EVM to give roughly accurate readings;
however, the EVM has not been calibrated while shipped. To maximize accuracy and to compensate
component and manufacturing tolerance, the EVM must go through a calibration process. This chapter will
discuss the techniques, procedures, and steps of calibration.

C.2 Calibration Techniques
To calibrate, use the instruments listed in Section 6.1 and connected properly as in Section 6.2. Calibrate
each phase.

This design requires a two-point calibration. VGAIN, IGAIN, PGAIN, VDC_OFFSET, and IDC_OFFSET
are parameters that will be calibrated during the process; an estimated value is put into the memory during
the design and characterization to help to speed up calibration.

VAC_OFFSET, IAC_OFFSET, and PHASE_CORRECT are parameters that may not need calibration but
a characterization would be sufficient for embedded metering application except for a high accuracy of
<0.1%.

NOTE: The calibration values are written in one flash page in the EVM, so when a new value needs
to be written the whole page is erased. The provided GUI will do the read, modify, and write
operations automatically. When using a user calibration facility, read the complete set of
calibration values, back them up, update the modified field, and write the complete set back
to the EVM.
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C.3 Calibration Procedures

C.3.1 Calibration of AC Parameters
Use the following steps to calibrate the AC parameters.

Calibrating VGAIN

1. Set VIN to line voltage.
2. Calculate the value for VGAIN with the formula

where
• VGAINn+1 is the new voltage calibration factor
• VGAINn is the original voltage calibration factor
• VREF is the reference meter voltage reading at the voltage set for VGAIN calibration
• VUUT is the unit under test voltage reading at the voltage set for VGAIN calibration (9)

Or, if percentage error is used (as with the provided calibration software),

(10)
3. Write and apply the calibrated VGAIN.

Calibrating IGAIN

1. Set to calibration current (for example, 5 A).
2. Calculate IGAIN value with the formula

where
• IGAINn+1 is the new current calibration factor
• IGAINn is the original calibration factor
• IREF is the reference meter current reading at the current set for IGAIN calibration
• IUUT is the unit under test current reading at the current set for IGAIN calibration (11)

Or, if percentage error is used (as with the provided calibration software),

(12)
3. Write and apply the calibrated IGAIN.
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Calibrating PGAIN

1. Set to calibration current (for example, 5 A) and power factor of 1.
2. Calculate PGAIN gain with the formula

where
• PGAINn+1 is the new power calibration factor
• PGAIN is the original power calibration factor
• PREF is the reference meter power reading at the power set for PGAIN calibration
• PUUT is the unit under test power reading at the power set for PGAIN calibration (13)

Or, if percentage error is used (as with the provided calibration software),

(14)
3. Write and apply the calibrated PGAIN.

C.3.2 Calibration of Current AC Offset
The current AC offset is the result of noise pickup, and the offset generated on the shunt resistor circuit
causes an illusion of having a finite current flowing when there is actually not current flowing through the
shunt. Although this noise current does not affect the power reading's accuracy, this illusion contributes to
the current reading and its accuracy, especially when the current is small. To offset this miscalculation, the
EVM firmware has the mechanism to remove this from the current reading. The steps to calibrate this
current offset are as follows:
1. Apply nominal voltage to make sure the EVM operates.
2. Remove all loading from the EVM.
3. Take multiple current readings (for example, 100) and take an average as I_NOISE (in A).
4. Calculate the current AC offset value with the equation

(15)

NOTE: This is a big number even in the case of a few mA of noise.

5. Write and apply the calibrated I_AC_OFFSET.

C.3.3 Calibration of Voltage AC Offset
In most cases, the voltage AC offset rarely affects the voltage reading and does not require calibration.
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C.3.4 Calibration of Phase Correction

1. Set the test set to generate rated voltage and set to calibration current (for example, 5 A).
2. Make sure calibrations are complete for PGAIN (at PF = 1).
3. Set the test set to output at power factor 0.5 (+ or – is not important at this point).
4. Note the power error.
5. Switch the test set to output at power factor 0.5 in the other direction to Step 3.
6. Note the power error.
7. At this point, both power errors should be approximately the same deviation but a different direction

from the calibrated power error at PF = 1.
• For example, at PF = 1, the calibrated error is 0.1%. If at PF = 0.5, the power error reads about

0.5%. Then at PF = –0.5, the power error should read about –0.3%.
8. Adjust the phase correction with time deviation from the current phase correction such that the power

errors at PF = ±0.5 are minimized.
• For example, if the current phase correction is 13 µs and 11 µs is desired, enter –2 into the phase

correction box of the manual calibration window.
9. Repeat for both phases.
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Appendix D EVM Specification

• Voltage operating range (with supplied power supply): 85 to 265-V AC
• Sample rate: 4000 Hz
• Sampling bit depth: 24 bits
• Polling report supported
• Update rate: Eight AC cycles
• UART communication data rate: 9600 bps
• Measurements: RMS voltage, RMS current, active power, reactive power, apparent power, power

factor, and line frequency
• Measurement voltage range: 0 to 265 VRMS AC (one phase), 0 to 125 VRMS AC (two phases)
• Measurement current range: 0 to 30 ARMS AC
• Voltage resolution: 1 mV
• Current resolution: 1 µA
• Active power resolution: 1 mW
• Reactive or apparent power resolution: 1 mW
• Power factor resolution: 0.001
• Frequency resolution: 0.01 Hz
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Appendix E Running on MSP430i2040 and MSP430i2041

The example IAR project has been configured for MSP430i2041. To run on MSP430i2040, follow these
steps once:
1. Open the workspace. After launching IAR 5.5, select File→Open→Workspace.

Figure 58. IAR 5.5 Launch Window
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When prompted to open the project, select emeters.eww from the project directory of the example
code.

Figure 59. Open Workspace Window

2. Set the option. Right click on the project emeter-app-i2041 and select Options...

Figure 60. Workspace Options

50 Running on MSP430i2040 and MSP430i2041 TIDU641–November 2014
Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU641


www.ti.com Appendix E

In the Options window, click on General Options on the left-hand column and then select the Target
tab. Then, in the Device section, click on the right-hand side button of the entry box and select
MSP430Ixxxx Family→MSP430I2040.

Figure 61. Options Window

Click on Linker in the left-hand column and select the Config tab. Then click on the right-hand button in
the Linker configuration file box.

Figure 62. Config Tab
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Select lnk430i2040_temp.xcl when prompted and click Open.

Figure 63. Selecting Default XCL File

When brought back to the Options window, click OK.

Figure 64. Finishing the Setting Changes
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When brought back to the main screen, select File→Save to save the setting.

Figure 65. Saving the Setting Changes

The project is now set for run on MSP430i2040. To have the project to run back on MSP430i2041, follow
the same steps except select MSP430Ixxxx Family→MSP430I2041 in the Options window and select
lnk430i2041_temp.xcl when prompted in the Linker configuration file box.
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